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SCADAPack Workbench Release Notes 
SCADAPack Workbench 6.6.10 Release Notes 

Application Version 
The SCADAPack Workbench application version is 6.6.10. 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.77 for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.77 for SCADAPack 4203 controllers 
o 2.25 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   

• The latest SCADAPack E firmware at the time of release is 8.20.1 for SCADAPack E Remote Terminal 
Units (RTUs). 

New Features (6.6.10) 
There are no new features in this release. 

Enhanced Features (6.6.10) 
• WI 61734: Updated the About dialog for the Schneider Electric email address, technical support 

information, and also updated Cybersecurity topic links 
• WI 61776: Removed applications for discontinued TransNet, Freewave, and MaxStream radios and 

SCADAPack SDI-12 driver from the SCADAPack IEC 61131-3 Workbench and Utilities CD 
• WI 65226: Updated the Check a Product link 
• WI 68121: Updated the Technical Support address  

Functional Changes (6.6.10) 
There are no functional changes for SCADAPack Workbench version 6.6.10. 

Fixed Issues (6.6.10) 
• WI 60889: Addressed SCADAPack Workbench vulnerabilities CVE-2020-27271 and CVE-2020-27273 
• WI 65055: Addressed SCADAPack Workbench vulnerability CVE-2022-0221 
• WI 65057: Addressed SCADAPack Workbench vulnerability CVE-2022-0221 
• WI 65134: Corrected a Visual Studio 2013 Isolated Shell installation issue and renamed the VS2013 

Isolated Shell on the DVD and the docs to the following: 
o vs_isoshell.exe 
o VS12-KB3107629.exe 

• WI 67050: Addressed SCADAPack Workbench vulnerabilities CVE-2022-2463, CVE-2022-2464,CVE-
2022-2465 
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Known Issues (6.6.10) 
• WI 64022: Workbench will sometimes require that a program be rebuilt and redownloaded, even if 

it hasn't changed, prior to entering debug mode.  

SCADAPack Workbench 6.6.8a Release Notes 

Application Version 
The SCADAPack Workbench application version is 6.6.8a. 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.77 for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.77 for SCADAPack 4203 controllers 
o 2.24 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   

• The latest SCADAPack E firmware at the time of release is 8.17.1 for SCADAPack E Remote Terminal 
Units (RTUs). 

New Features (6.6.8a) 
•  There are no new features in this release. 

Enhanced Features (6.6.8a) 
• SCADAPack Workbench 6.6.8a is automatically licensed. It is not necessary to obtain a new license 

after upgrading.  See the user manual for details. 

Functional Changes (6.6.8a) 
SCADAPack Workbench version 6.6.8a provides the following functional changes. 

• WI 61776: Obsolete applications for TransNet, Freewave, and MaxStream radios are removed from 
the installation program. The discontinued SCADAPack SDI-12 Driver is removed from the 
installation program. 

Fixed Issues (6.6.8a) 
• WI 61831: The Help Viewer in 6.6.8 opened a PDF version of the help. This is corrected in 6.6.8a. The 

PDF version of the file is removed, and the normal help viewer functions as designed. 
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SCADAPack Workbench 6.6.8 Release Notes 

Read Before Installation 
A new license is required after installation of SCADAPack Workbench 6.6.8. Allow time to obtain a new 
license when planning your installation. 

When installing SCADAPack Workbench 6.6.8 on a computer that was running a previously licensed 
version, a message states that the free version is running. This means you need to activate the 
SCADAPack Workbench 6.6.8 license. To obtain new license registration keys, contact Schneider Electric 
customer support at ordersTRSS@se.com. 

Application Version 
The SCADAPack Workbench application version is 6.6.8. 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.77 for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.77 for SCADAPack 4203 controllers 
o 2.24 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   

• The latest SCADAPack E firmware at the time of release is 8.17.1 for SCADAPack E Remote Terminal 
Units (RTUs). 

New Features (6.6.8) 
•  There are no new features in this release. 

Enhanced Features (6.6.8) 
• The ISaGRAF Gateway OPC® Data Access Server version 6.6 with load on demand enables 

monitoring applications running on controllers with either big-endian or little-endian format for 
communication with an ISaGRAF version 5 target. 

• Import or export variables in Excel Workbook .xlsx format. This format supports up to 1,048,576 by 
16,384 rows and columns. 

Technical Notes (6.6.8) 
• When performing searches from the Solution Explorer to locate specific items within the tree 

structure, searches are case-insensitive for lowercase text in the search field. However, searches 
become case-sensitive upon entering uppercase text in the field. Microsoft states this behavior is as 
designed: https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-
explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive  

• When SCADAPack Workbench displays a message that the ACP has encountered a problem, please 
take the time to generate a report to help us improve the quality of our product. When generating a 
report, you can choose to capture and attach a screenshot. Upon generation, a dialog box indicates 

mailto:ordersTRSS@se.com
https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive
https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive
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the location and name of the report where you can choose to send the file to our technical support 
team at supportTRSS@se.com. For such problems, make sure to close SCADAPack Workbench 
without saving changes to your project and restart the software to avoid corrupting files. 

Functional Changes (6.6.8) 
SCADAPack Workbench version 6.6.8 provides the following functional changes. 

• User Story 39895: (ISE6-1291) The Start menu organization is updated to work better with Windows 
10. 

CAM 3 and CAM 5 

• The Debug menu no longer displays the Parallel Stacks and Parallel Watch commands while the 
project is in simulation mode. 

• Complex inputs of a user-defined function display N/A in the LD language editor. Previously, 
complex inputs of a user-defined function displayed the value OFFLINE. 

• Entering a comment with more than 60 characters for an I/O channel displays the message The 
maximum length for this field is 60 characters. SCADAPack Workbench prevents saving 
comments for an I/O channel with more than 60 characters. Previously, SCADAPack Workbench 
accepted comments with more than 60 characters for an I/O channel. When building the 
project, a comment with more than 60 characters caused a build error. 

• In the SFC editor, adding an LD transition creates a level 2 LD language container with a rung and 
a coil. The LD transition sets the following restrictions:  

o The coil cannot be deleted. 
o The coil cannot be assigned a variable. 
o A new rung cannot be added. 

ISaGRAF version 6.6.3 allows deleting empty coils and prevents assignment of variables to 
empty coils.  

CAM 3 

• The boolean variable values MsgTrue and MsgFalse are not supported. These variables values were 
supported in ISaGRAF version 3.x.x. Remove any MsgTrue and MsgFalse values before importing an 
ISaGRAF version 3.x.x project. 

• Right-clicking a POU in Solution Explorer does not display Clean. In ISaGRAF version 6.3, right-
clicking a POU in Solution Explorer and then selecting Clean cleans the project. 

• This release does not support ISaGRAF 3 resource (*.rsc) files. 

 

Fixed Issues (6.6.8) 
• WI 57547: SCADAPack Workbench reported “too many I/O variables” under Windows 10 but 

compiles successfully on Windows 7. This is fixed. 

mailto:supportTRSS@se.com


 

Internal 

• WI 40003: (ISE6-1165) There is no warning with the Modbus Master Polling function blocks when 
both Start_reg_5digit and Start_reg_6digit parameters are configured. This is by design, but was not 
documented. The behaviour has been documented. 

• WI 39888: (ISE6-1299) SCADAPack Workbench Quick Start Guide was available twice under the 
Windows 10 and 8 Start Menu. This is fixed. 

• WI 39889: (ISE6-1298) SCADAPack Workbench could not build a CAM3 project on Windows 10 on 
some workstations. This is fixed. 

• WI 56699: An Online change displayed an error message when building for a SCADAPack 334E on 
some workstations. This is fixed. 

• WI 40027: (ISE6-1140) The Comparison (=) Function block gave incorrect result when one input was 
manually set, and the other input came from the output of a function block. This is corrected. 

CAM 3 and CAM 5 
• This release corrects the issues described in Rockwell Automation Product Safety Advisory (PSA) 

2019-08-002. 
• In the FBD or LD editor, variables with names that include an underscore immediately followed 

by a digit such as _1, _2, _1_1_1 do not display the power flow coloring, data type, and online 
value for the variable. [Rockwell TFS 35187] 
In this release, in the FBD or LD editor, variables with names that include an underscore 
immediately followed by a digit such as _1, _2, _1_1_1 display the power flow coloring, data 
type, and online value for the variable. 

• ISaGRAF does not support adding a second device from the ISaFREE template in the Deployment 
view. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 52386] 
In this release, ISaGRAF supports adding a second device from the ISaFREE template in the 
Deployment view. 

• When debugging an FBD POU, the input value of a function displays an incorrect value. 
[Rockwell TFS 58980] 
In this release, when debugging an FBD POU, the input value of a function does not appear. 

• When downloading a device using a serial port when no serial port is found on the computer, an 
error message appears. [Rockwell TFS 51673] 
In this release, when downloading a device using a serial port when no serial port is found on 
the computer, the Output window displays an error. 

• Deleting a group of variables that are sorted by name from the dictionary and then undoing the 
deletion may select the current row as well as undeleted rows. [Rockwell TFS 40993] 
In this release, deleting a group of variables that are sorted by name from the dictionary and 
then undoing the deletion selects only the current row.  

• The Online Change toolbar icon and shortcut menu do not appear in the Japanese version of the 
Automation Collaborative Platform. [Rockwell TFS 41347] 
In this release, the Online Change toolbar icon and shortcut menu appear in the Japanese 
version of the Automation Collaborative Platform. 

• Importing a .tdb file that has an added, modified, or deleted Network Resource Binding 
parameter displays the error message "Unhandled exception occurred during the filling of the 
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table Instance of ResNetPara". The project does not update. Closing the error message closes 
the project and the project cannot re-open. [Rockwell TFS 51033] 
In this release, importing the .tdb file that has an added, modified, or deleted Network Resource 
Binding parameter updates the project.   

• The I/O Device view of a resource does not open after creating an I/O device instance that has 
2000 channels and then closing and re-opening the project. The Output window displays the 
message "Exception of type 'System.OutOfMemoryException' was thrown" and an error 
message appears. [Rockwell TFS 37000] 
In this release, the I/O Device view of a resource opens after creating an I/O device instance that 
has 2000 channels and then closing and re-opening the project.  

• Importing an ISaGRAF version 5.22 project and library replaces manual instances of function 
blocks with automatic instances. [Rockwell TFS 52260] 
In this release, importing an ISaGRAF version 5.22 project and library retains manual instances of 
function blocks. 

• Deleting a derived type variable that is monitored in the Spy List and then debugging the 
application displays an error message. [Rockwell TFS 62556] 
In this release, deleting a derived type variable that is monitored in the Spy List and then 
debugging the application displays an Invalid icon for the deleted variable n the Spy List. 

• In Document Overview, zooming in on a link between two variables does not display the 
selected area and displays an error message. [Rockwell TFS 48833]  

• In this release, zooming in on a link between two variables displays the selected area.  
• Attempting to display the properties of a resource in Device view displays an error message. 

[Rockwell TFS 42818]  
• In this release, the properties of a resource appear in Device view. 
• If the Project location or POU name includes Chinese characters, building a solution that has a 

POU fails and the Output window displays an error. [Rockwell TFS 61819] 
In this release, if the Project location or POU name includes Chinese characters, the Chinese 
characters do not cause an error when building.  

• Importing an exchange file displays an error message if the imported resource name and the 
program name are the same. [Rockwell TFS 51117]  

• In this release, the error message “Unable to import the file; the file may be corrupted or in an 
invalid format" appears if the imported resource name and the program name are the same.  

• When using automatic instances of function blocks, the values of function block outputs do not 
appear in debug mode. [Rockwell TFS 41162]  

• In this release, when using automatic instances of function blocks, the values of function block 
outputs appear in debug mode.  

• Copying and pasting a POU body that contains library function blocks from one FBD program to 
another does not paste the correct data types for instances of function blocks. [Rockwell TFS 
58991]  

• In this release, copying and pasting a POU body that contains library function blocks from one 
FBD program to another pastes the correct data types for instances of function blocks. 
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• The Spanish version of the ISaGRAF opens the English version of the Automation Collaborative 
Platform when selecting Start > All Programs > ISaGRAF x.x > Automation Collaborative Platform 
x.x. [Rockwell TFS 27157]  

• In this release, the Spanish version of ISaGRAF opens the Spanish version of the Automation 
Collaborative Platform when selecting Start > All Programs > ISaGRAF x.x > Automation 
Collaborative Platform x.x.   

• After editing an ST POU body, the Cross Reference Browser incorrectly displays an icon 
indicating that the cross reference data is up-to-date. [Rockwell TFS 26173] 
In this release, after editing an ST POU body, the Cross Reference Browser displays a warning 
icon indicating that the cross reference data is out of date. 

• Building a project that has an FBD POU body that contains an unconnected vertical bar, left 
power rail, or right power rail displays an error message. [Rockwell TFS 27484] 
In this release, building a project that has an FBD POU body that contains an unconnected 
vertical bar, left power rail, or right power rail displays the applicable message in the Output 
window. Double-clicking the message in the Output window displays the language editor with 
the unconnected component selected.  

• Deleting branches from a rung in the LD POU editor takes excessive time. [Rockwell TFS 40867] 
In this release, deleting branches from a rung in the LD POU editor takes a similar duration as in 
ISaGRAF version 6.2. 

• Scrolling the language editor while debugging an ST program causes the yellow arrow that 
indicates a breakpoint to disappear. [Rockwell TFS 57317] 
In this release, scrolling the language editor while debugging an ST program does not cause the 
yellow arrow that indicates a breakpoint to disappear. 

• Undoing changes made to the FBD POU in the language editor does not revert the last change 
and misplaces elements and connections lines. [Rockwell TFS 50464] 
In this release, undoing changes made to the FBD POU in the language editor reverts the last 
change and the placement of elements and connection lines. 

• Naming a project with unsupported characters opens the Enter Password dialog box. [Rockwell 
TFS 52321] 
In this release, naming a project with unsupported characters opens an error message. 

• Copying and pasting 15 or more rungs in a ladder diagram takes excessive time. Anomaly first 
identified in ISaGRAF version 6.5. [Rockwell TFS 48250] 
In this release, copying and pasting 15 or more rungs in a ladder diagram takes a similar duration 
as in ISaGRAF version 6.4.1. 

• Renaming bit access or array member variables in the dictionary does not display a yellow 
warning symbol for elements with errors in the LD language editor. [Rockwell TFS 55974] 
In this release, renaming bit access or array member variables in the dictionary displays a yellow 
warning symbol for elements with errors in the LD language editor. 

• Changing the data type of an instance of a function block in the dictionary does not update the 
name of the function block in the LD language editor. [Rockwell TFS 55990] 



 

Internal 

In this release, changing the data type of an instance of a function block in the dictionary 
updates the name of the function block in the LD language editor. 

• The ISaGRAF compiler may generate errors when a function block that does not have inputs 
serves as the input for multiple function blocks in an incorrect FBD POU execution order. 
Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 30643] 
In this release, to help prevent errors, the ISaGRAF compiler processes the function block 
serving as the input for the multiple function blocks before processing other function blocks. 

• Opening an LD POU takes excessive time. [Rockwell TFS 48276, TFS 48088] 
In this release, opening an LD POU takes a similar duration as in ISaGRAF version 6.4. 

• A project builds even when the array or structure size exceeds the 2 GB limit. [Rockwell TFS 
48330] 
In this release, when the array or structure size exceeds the 2 GB limit, the project build fails and 
a compilation error appears. 

• Using an exchange file to import a POU takes excessive time when a POU body is open. 
[Rockwell TFS 49981] 
In this release, the time it takes to use an exchange file to import a POU when the POU body is 
open is reduced. 

• The CAM 3 compiler generates power flow debugging information for a POU even if the 
Generate Debug Info property is set to False. [Rockwell TFS 40756] 
In this release, the CAM 3 compiler does not generate power flow debugging information if the 
Generate Debug Info property is set to False. 

• In some localized versions of the Automation Collaborative Platform, the Error List incorrectly 
displays warnings as errors. [Rockwell TFS 44515] 
In this release, the Error List in localized versions of the Automation Collaborative Platform 
displays generated warnings as warnings. 

• Adding a variable to the Spy List displays variable values as OFFLINE. Displaying values for added 
variables in the Spy List required closing and reopening the Spy List. [Rockwell TFS 46489] 
In this release, adding a variable to the Spy List displays the values without having to close and 
reopen the Spy List. 

• Importing an ISaGRAF version 5 project fails to download code to the target. Ladder Diagram 
Optimized Code in Target Features displays an incorrect value.  [Rockwell TFS 60208] 
In this release, importing an ISaGRAF version 5 project downloads code to the target. Ladder 
Diagram Optimized Code in Target Features displays the correct value based on the 
FeatureOptCode value in the .mdb file for the imported project:  

o True: FeatureOptCode = Yes 
o False: FeatureOptCode = No 
o False: FeatureOptCode has no value 

• After adding an I/O device, opening an I/O parameter changes the default float parameter value 
from 0 to 0.0 in the I/O Parameter dialog box. Reopening the I/O parameter and clicking OK in 
the I/O Parameter dialog box displays the error message “The value is either too large of too 
small for [parameter]”. [Rockwell TFS 57584] 
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In this release, opening an I/O parameter does not change the default float parameter value 
from 0 to 0.0 in the I/O Parameter dialog box. The I/O Parameter dialog box accepts any 0 float 
values such as 0 and 0.0. 

• Deleting an array used in a structure prevents creating elements in the structure. [Rockwell TFS 
42629] 
In this release, deleting an array used in a structure does not prevent creating elements in the 
structure. 

• Changing the Logical Value for a variable in the dictionary displays the value WAIT. [Rockwell TFS 
43629] 
In this release, changing the Logical Value for a variable in the dictionary displays the entered 
value. 

• Adding a variable to the Spy List displays variable values as OFFLINE. Displaying values for added 
variables in the Spy List requires closing and reopening the Spy List. [Rockwell TFS 46489, TFS 
43838] 
In this release, adding a variable to the Spy List displays the values without having to close and 
reopen the Spy List. 

• Debugging or simulating a project consumes excessive memory when an ST POU references 
variables. Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 52572] 
In this release, memory consumption is stable while debugging or simulating a project that 
contains an open ST POU that references variables. 

• The FBD compiler does not create a MEMO variable for each instance of a P/N contact. This 
behavior is inconsistent with the LD compiler behavior and may lead to unexpected build 
results. [Rockwell TFS 43995] 
In this release, the FBD and LD compilers create a MEMO variable for each instance of a P/N 
contact by default.  

• The DisableNewLDMemoContacts parameter value in the Diamond.ini file determines the 
behavior of P/N contacts: 

o 0 = create a MEMO variable for each instance of a P/N contact 
o 1 = create only one MEMO variable for all the instances of a P/N contact 

• Copying a rung that has a ladder and a user-defined function block and then pasting the rung to 
another ladder displays hidden parameters in the LD language editor. [Rockwell TFS 50797] 
In this release, pasting the copied rung no longer displays hidden parameters. 

 
CAM 5  

• The SCADAPack Workbench exits without saving when double-clicking an I/O device instance in 
a project imported from an exchange file. [Rockwell TFS 66429] 

• LD POUs containing backward jumps may execute the application in an infinite loop. [Rockwell 
TFS 66506] 

• FBD POUs containing backward jumps may execute the application in an infinite loop [Rockwell 
TFS 66605] 
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• For FBD POU bodies, incorrectly closing comments causes unexpected compiler errors. 
[Rockwell TFS 48610] 
In this release, no compiler errors appear. 

• When simulating a project that has a dependency on a library, error symbols for “Undefined 
POU” appear in the language editor even if the location of the library is defined. [Rockwell TFS 
39620] 
In this release, when simulating a project that has a dependency on a library, error symbols for 
“Undefined POU” do not appear in the language editor if the location of the library is defined. 

• Closing a project takes excessive time compared to ISaGRAF version 6.4.1. [Rockwell TFS 61521] 
In this release, the length of time to close a project is reduced. 

• When importing a POU from a password-protected resource, an error message appears. 
[Rockwell TFS 62564] 
In this release, importing a POU from a password-protected resource prompts the user to enter 
the password. 

• The function block instance input displays incorrect values in the POU body when Flexible Array 
and FB Parameters by Reference in Target Features is set to True. [Rockwell TFS 55076] 
In this release, the function block instance input displays correct values in the POU body when 
Flexible Array and FB Parameters by Reference in Target Features is set to True. 

• Importing a project created from a previous software version that has password-protected POUs 
prompts the user to enter a password for each POU. [Rockwell TFS 50528] 
In this release, importing the project from a previous software version that has password-
protected POUs does not prompt the user to enter a password for each POU. Opening the POU 
in the language editor prompts the user to enter a password. 

• Deleting an embedded user-defined function block (UDFB) displays the message “Cannot 
convert a complex type to a single type” in the Output window and displays and error message. 
This anomaly occurs when retaining local variables for the instance of the embedded UDFB. 
[Rockwell TFS 56288] 
In this release, deleting the embedded UDFB removes the UDFB and the instance of the 
embedded UDFB becomes undefined. 

• Opening I/O Device view and changing the I/O device selection takes excessive time for a large 
wired array such as [1…2000]. [Rockwell TFS 62580] 
In this release, the I/O Device view opens in less than 30 seconds and changing the I/O device 
selection is faster. 

• The Automation Collaborative Platform does not import a resource that has a duplicate 
producing group ID in the project. An error message appears. [Rockwell TFS 38447] 
In this release, the Automation Collaborative platform supports importing a resource that has a 
duplicate producing group ID in the project. Entering an ID value in the Properties window for a 
producing group in a binding displays the message "Property value is not valid" if another 
producing group with the same ID exists in the resource. 

• Making changes to Global Variables before performing an online change does not rebuild the 
project and displays incorrect variable values. [Rockwell TFS 57212]  
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• In this release, making changes to Global Variables before performing an online change rebuilds 
the project and displays correct variable values.  

• Changing the size of the dimension of an Array data type that a Structure data type uses displays 
an error message. Selecting the Structures tab in Data Types closes the Automation 
Collaborative Platform. [Rockwell TFS 60911]  

• In this release, changing the size of the dimension of an Array data type that a Structure data 
type uses applies the size change.  

• Selecting Tools > Execution Order does not display the execution order of a function block 
diagram in the language editor if the POU body contains an unconnected block. [Rockwell TFS 
49518] 
In this release, selecting Tools > Execution Order displays the execution order of a function block 
diagram in the language editor even if the POU body contains an unconnected block. 

• Renaming a POU in a project that uses bindings and then building the project changes the 
configuration of the bindings of local variables. The Error List indicates that a variable in the 
binding is not found. [Rockwell TFS 55721] 
In this release, renaming a POU in a project that uses bindings and then building the project 
does not change the configuration of the bindings of local variables. 

• Incremental builds omit child SFC POUs with changes to global variables or data types. Anomaly 
first identified in ISaGRAF version 6.4. [Rockwell TFS 58701, TFS 50731] 
In this release, incremental builds include SFC children with changes to global variables or data 
types. The number of child SFC POUs may affect build time. 

• Copying and pasting program POUs or variables takes excessive time. Anomaly first identified in 
ISaGRAF version 6.5. [Rockwell TFS 50931] 
In this release, copying and pasting POUs or variables takes a similar duration as in ISaGRAF 
version 6.4.1. 

• Adding a POU online and then restarting the resource does not start an SFC program. [Rockwell 
TFS 44361] 
In this release, adding a POU online and then restarting the resource starts the SFC program. 

• Yes to All and No to All buttons do not appear when prompted to stop downloading a resource 
from a previously downloaded project that has multiple resources. [Rockwell TFS 40796] 
In this release, the Yes to All and No to All buttons appear in the dialog box when prompted to 
stop downloading a resource from a previously downloaded project that has multiple resources. 

• The ISaGRAF compiler generates unrecognized 1 GAIN LD optimization TIC codes on the ISaGRAF 
version 5.22 target. Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 36948] 
In this release, the ISaGRAF compiler does not generate unrecognized TIC codes on the ISaGRAF 
version 5.22 target. 

• Opening the Variable Selector takes excessive time. [Rockwell TFS 50229, TFS 51253] 
In this release, opening the Variable Selector takes a similar duration as in ISaGRAF version 6.4. 

• When attempting to view the cross reference for a password-protected variable, selecting 
Cancel on the Enter Password dialog box causes SCADAPack Workbench to stop responding. 
[Rockwell TFS 51364] 
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In this release, when attempting to view the cross reference for a password-protected variable, 
selecting Cancel closes the Enter Password dialog box. 

• The ISaGRAF compiler miscalculates OEM parameter offsets for simple and complex I/O devices 
in the resource configuration file.  Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 
47551] 
In this release, the compiler correctly calculates the OEM parameter offsets for simple and 
complex I/O devices in the resource configuration file. 

• Building and then debugging an imported project does not retain all Retained variables for non-
enhanced targets. [Rockwell TFS 41358] 
In this release, building and then debugging an imported project retains all Retained variables 
for non-enhanced targets. Retaining sub-variables or instances of function blocks for non-
enhanced targets displays a compilation error when building and then debugging the project. 

• The dictionary displays an incorrect selection in the Retained column for variables of an 
imported device or POU. [Rockwell TFS 51722] 
In this release, the dictionary displays correct values in the Retained column for variables of an 
imported device or POU based on the IsRetained value in the exchange file: 

o selected: IsRetained = true for all variable subfields  
o cleared: IsRetained = false for all variable subfields 
o shaded: IsRetained = true for some variable subfields, IsRetained = false for some 

variable subfields 
• Connection to multiple controllers fails if one of the controllers is not running. [Rockwell TFS 

51688] 
In this release, connection to multiple controllers does not fail if one of the controllers is not 
running.  

• When stopping debugging of an online project that has SFC and other programming language 
breakpoints, changing a resource from stepping mode to run mode when prompted stops the 
resource from running. The Diagnostic tool displays the Resource Mode value Break. [Rockwell 
TFS 35050] 
In this release, when stopping debugging of an online project that has SFC and other 
programming language breakpoints, changing a resource from stepping mode to run mode 
when prompted does not stop the resource from running. The Diagnostic tool displays the 
Resource Mode value RealTime. 

• In debug mode, locking an element of a structure variable in the dictionary or Spy List when the 
Locked Variables window is open displays an error message and does not lock the element. 
[Rockwell TFS 50985] 
In this release, locking an element of a structure variable in the dictionary or Spy List when the 
Locked Variables window is open locks the element. 

• Adding a structure or array data type to the library and then building the project without saving 
the library displays an error message. [Rockwell TFS 38984] 
In this release, adding a structure or array data type to the library and then building the project 
without saving the library does not display an error message. 
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• Building a project that contains a STRING array as a function input parameter causes a build 
error with address overlaps. [Rockwell TFS 49373] 
In this release, building a project that contains a STRING array as a function input parameter 
does not cause a build error with address overlaps. 

• Changing the index of a complex I/O device instance in a project may result to a build error. 
Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 50078] 
In this release, changing the index of a complex I/O device instance in a project does not cause a 
build error. 

CAM 3  
• Cannot lock an I/O variable with an offset is greater than 4096. The lock request is executed on 

the incorrect variable. [Rockwell TFS 59076] 
In this release, the lock request executes on the correct I/O variable when the offset is greater 
than 4096. 

• The Network Connection property Stop Bits incorrectly displays the options None, One, Two, 
and OnePointFive. [Rockwell TFS 51674] 
In this release, the values are listed in numerical order and display correctly as 0, 1, 1.5, and 2. 

• Renaming an ISaVIEW screen removes programs, functions, and function blocks from the 
project. [Rockwell TFS 62853] 
In this release, renaming an ISaVIEW screen does not remove programs, functions, and function 
blocks from the project. 

• The message “Would you like to build?” appears when restarting the simulation of an 
application that is saved and built without error, even if there are no changes to the application. 
This anomaly occurs if the POU body contains a function block instance and Generate Debug 
Info is set to True in the Properties window for the Function Block Diagram (FBD) or Ladder 
Diagram (LD) POU. [Rockwell TFS 62187] 
In this release, the message “Would you like to build?” does not appear when restarting the 
simulation of an application that is saved and built without error. 

• Assigning a conversion function or table to an I/O variable in the I/O Wiring tool does not display 
the assigned function after saving and re-opening the project. [Rockwell TFS 39456]  

• In this release, assigning a conversion function or table to an I/O variable in the I/O Wiring tool 
displays the assigned function after saving and re-opening the project.   

• Changing the data type of a local variable of a function block and then building and simulating 
the application does not display updated variable values when opening the dictionary. An error 
message appears. [Rockwell TFS 59613]  

• In this release, changing the data type of a local variable of a function block and then building 
and simulating the application displays updated variable values when opening the dictionary. 

• In the Cross Reference Browser, right-clicking a block in the References pane and selecting Go to 
Reference does not display the POU language editor for the block. [Rockwell TFS 46171]  

• In this release, right-clicking a block in the References pane and selecting Go to Reference 
displays the POU language editor for the block. 
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• Entering a negative value in Cycle Timing (ms) for a device displays an error message. [Rockwell 
TFS 26128]  

• In this release, entering a negative value in Cycle Timing (ms) does not change the value Cycle 
Timing (ms).  

• The Generate Documentation output file does not display OEM parameters of I/O devices. 
[Rockwell TFS 59481]  

• In this release, the Generate Documentation output file displays OEM parameters of I/O devices.  
• When using a Windows 10 operating system, a project does not build if the project has an LD 

POU that uses a defined word. An error message appears. [Rockwell TFS 54929]  
• In this release, when using a Windows 10 operating system, having an LD POU that uses a 

defined word in the project does not cause an error when building. 
• Cleaning a project incorrectly deletes all files with a file extension that begins with x, for 

example .xml and .xls, and resets the application number to 1. [Rockwell TFS 59078] 
In this release, cleaning a project only deletes the intermediate and output files generated 
during the last build operation. 

• Renaming the target device empties library POU bodies, which causes the project build to fail. 
[Rockwell TFS 59519] 
In this release, renaming the target device does not modify POUs in the library. 

• The Error List for build errors displays the file extension without the POU file name in the File 
column. [Rockwell TFS 43790] 
In this release, the Error List for build errors displays the POU file name with the file extension in 
the File column. 

• When debugging an LD program, the language editor may not display the correct line color for 
monitoring the function block output. [Rockwell TFS 47955] 
In this release, the language editor displays the correct line color for monitoring function block 
outputs: 

o black – the output value is unavailable 
o red – the output value is true 
o blue – the output value is false 

• For FBD, LD, and ST programs, double-clicking an error in the Error List does not highlight the 
variable shape that has an error in the language editor. [Rockwell TFS 55053] 
In this release, double-clicking an error in the Error List highlights the variable shape that has an 
error in the language editor. 

• The language editor is editable while in debug mode when the application cannot connect to the 
target. [Rockwell TFS 43579] 
In this release, the language editor is read-only while in debug mode when the application 
cannot connect to the target. 

• If a variable has a comment with more than 60 characters, building a project displays an error 
message. [Rockwell TFS 45819] 
In this release, entering a comment to a variable displays a warning if the comment exceeds 60 
characters and does not save the comment. Importing an .xls file that contains a variable 
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comment with more than 60 characters imports the variable but clears the comment from the 
variable. 

• If the I/O Wiring tool is open, downloading or simulating a project fails. [Rockwell TFS 38242] 
In this release, if the I/O Wiring tool is open, it does not cause the download or simulation of a 
project to fail. 

• Selecting Unlock in the Locked Variables viewer does not unlock the selected variables. 
[Rockwell TFS 38140] 
In this release, selecting Unlock in the Locked Variables viewer unlocks the selected variables. 

• Importing variables using an .xls file does not import I/O wirings of complex devices. [Rockwell 
TFS 45834] 
In this release, importing variables by using an .xls file imports I/O wirings if the I/O device 
supports I/O wiring. A warning appears if there are invalid I/O wirings in the imported .xls file. 

• Importing an ISaGRAF 3 project takes excessive time. [Rockwell TFS 46940] 
In this release, importing an ISaGRAF 3 project takes a similar duration as in ISaGRAF version 6.4. 

• Building and then simulating a project that has nested in-line function blocks displays an 
incorrect POU build order. [Rockwell TFS 60920] 
In this release, building and then simulating a project that has nested in-line function blocks 
displays the correct POU build order. 

• When building a project or library that has two local function block instances in two ST programs 
that have the same name, the compiler recognizes a function block instance as global instead of 
local. [Rockwell TFS 59634] 
In this release, when building a project or library that has two local function block instances in 
two ST programs that have the same name, the error “[FB instance]: name already used for 
another object [FB instance]” appears in the Output window and error message.  

• After changing the order of an I/O board instance in the I/O Wiring tool and then building the 
application, downloading the application to the target displays an error message. [Rockwell TFS 
59119] 
In this release, changing the order of an I/O board instance in the I/O Wiring tool and then 
building the application does not cause the download of the application to the target to fail. 

• Renaming a wired variable that is used by a POU and then building the application does not 
rebuild the POUs. Downloading the application to the controller displays an error in the 
controller. [Rockwell TFS 58662] 
In this release, to help prevent downloading errors, renaming a wired variable and then building 
the application without updating the POUs generates a build error. 

• Downloading a project takes excessive time. [Rockwell TFS 46462] 
In this release, downloading a project takes a similar duration as in ISaGRAF version 3. 

• Building an imported project that has a file with a file name of more than 20 characters displays 
an error message. [Rockwell TFS 46516] 
In this release, building an imported project that has a file with a file name of more than 20 
characters does not display an error message. 



 

Internal 

• When debugging an LD or FBD program, the language editor may not display the correct line 
color for monitoring the function block output. [Rockwell TFS 47955, TFS 58350, TFS 40915] 
In this release, when debugging an LD or FBD program, the language editor displays the correct 
line color for monitoring function block outputs: 

o black – the output value is unavailable 
o red – the output value is true 
o blue – the output value is false 

• Changing the initial value of a variable of an FBD program and then downloading the application 
to the controller retains the original initial value. [Rockwell TFS 43715] 
In this release, changing the initial value of a variable of an FBD program project and then 
downloading the application to the controller resets the initial value to 0.   

• If a project contains more than 4096 boolean variables or more than 4096 analog variables, 
forcing the value of a locked output variable may not change the physical value. Forcing the 
value of a locked input variable may incorrectly change the physical value. [Rockwell TFS 61795] 
In this release, forcing the value of a locked output variable modifies the physical value. Forcing 
the value of a locked input variable does not change the physical input value and modifies the 
logical value. 

Known Issues (6.6.8) 
CAM 3 and CAM 5 

• When canceling the import of an exchange file, ISaGRAF displays an incorrect message while the 
cancelation is successful. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 24329] 
There is no workaround. 

• The Dictionary displays the incorrect lock status of variable members. Anomaly first identified in 
ISaGRAF version 6.3.2. [Rockwell TFS 41362] 
To work around this issue, view the correct lock status for variable members in the Locked 
Variables viewer. 

• When resetting the toolbox for FBD, LD, SFC, or ST programming languages, the icons for some 
or all elements may not display correctly. Anomaly first identified in ISaGRAF version 6.4.1. 
[Rockwell TFS 26106] 
To work around this issue, close and reopen ISaGRAF. 

• In the Customize dialog box for menu bar, toolbar, and context menu items, applying the Reset 
All command may cause an unexpected behavior. Anomaly first identified in ISaGRAF version 
6.4.1. [Rockwell TFS 27178] 
To work around this issue, remove the effects from having applied the Reset All command, reset 
all environment settings to the default by selecting Import and Export Settings > Reset all 
settings from the Tools menu. 

• When generating documentation for projects, devices, and programs from the Generate 
Document window, the generated document does not contain the functions and function blocks 
of a library. [Rockwell TFS 44178] 
To generate documentation for functions and function blocks of a library, copy the functions 
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and function blocks of a library to a new project, and then generate documentation from the 
new project. 

• Inserting a block from the Block Library to a function block in the FBD editor displays the Enter 
Password dialog if the function block is used in a password-protected program. Selecting Cancel 
inserts the block without the variable instance for the function block. [Rockwell TFS 55926] 

• The find and replace feature only enables using the Find Next and Replace commands with the 
Current Document option for POUs. [Rockwell TFS 25826] 
Perform searches and replacements for a selected POU body by pressing Ctrl+F, then setting the 
Look In field to Current Document and using only the Find Next or Replace commands. 

• When a project has two targets that contain the same C function blocks, changing the target 
displays an error when building the project. The reference data types appear undefined. 
[Rockwell TFS 39238] 
Correct the data types manually. 

To work around this issue: 

1. Export the project. 
2. Create a new simulator project. 
3. Import the target definition in the new project. 
4. Change the target type of the device. 
5. Import the resource under the device. 
6. Copy and paste define words from the original project to the new project. 

• Modifying the structure of a function block causes SCADAPack Workbench to stop responding. 
This anomaly occurs when an associated variable with a retained value already exists in a 
dictionary. [Rockwell TFS 52495] 
There is no work around. 

• The cycle overflow warning is not informative. The parameter is always 0. The resource that 
caused the overflow is not identified. [Rockwell TFS 44697] 
There is no work around. 

• The Cross Reference Browser does not display variable references located in SFC transitions. 
This behavior is inconsistent with the Cross Reference Browser behavior in ISaGRAF version 6.4. 
[Rockwell TFS 50453] 
There is no work around. 

• Simulation of a project does not start if the project folder name has a hyphen, for example, 
Project1 - Copy. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 61901] 
To work around this issue, remove hyphens from the project folder name before simulating the 
project. 

• Selecting the Show Topic in Contents button in Microsoft Help Viewer does not display the 
selected topic in the Contents tab. Anomaly first identified in ISaGRAF version 6.6.7. [Rockwell 
TFS 65597] 
To work around this issue, when performing a search in Search tab, click the search result twice 
and then click the Show Topic in Contents button. 
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• The Cross Reference Browser may not list all variables, blocks, and defined words as used in a 
project if an operator and a literal value in an ST statement do not have a space in between, for 
example, myInt := 1 +2. [Rockwell TFS 60722] 
To work around this issue, use a space between the operator and literal value in ST statements, 
for example, myInt := 1 + 2. 

CAM 5 
• After importing a project from an exchange file, additional I/O devices appear in Device Selector. 

Adding these I/O devices causes unexpected results in the application. [Rockwell TFS 67052] 
To avoid this issue, create a project by using the required project template, and then import 
each device from the exchange file. 

• When importing variables, no validation occurs to check that wiring definitions correspond to 
array dimensions or structure data types. Anomaly first identified in ISaGRAF version 6.4. 
[Rockwell TFS 34230] 
To work around this issue, before importing wired array or structure variables, make sure that 
the number of wirings corresponds to the number of members of those variables. 

• When changing a dependency path for a library, ISaGRAF may display the Property value is not 
valid message. Anomaly first identified in ISaGRAF version 6.6. [Rockwell TFS 42479] 
To work around this issue, close and re-open the project to update the dependency path. 

• For SFC and IEC 61499, elements or files may be missing when opening projects from the version 
source control repository. Anomaly first identified in ISaGRAF version 6.2. [Rockwell TFS 
13338/33850] 
There is no workaround. 

• Initial values are not supported for Inputs of user-defined function blocks programmed in SFC. 
Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 65515] 
To work around this issue, use LD, ST, FBD user-defined function blocks. 

• When updating a solution or resource from an exchange file or from a repository, the variables 
are missing from the variable groups. Anomaly first identified in ISaGRAF version 6.3.2. 
[Rockwell TFS 24302] 
There is no workaround. 

• When the compiler is unable to produce TIC code for FBD networks, the error list displays a 
warning message stating that the element is part of a tree not producing any code. 
To work around this issue and enable the production of TIC code, modify the network: 

o For rungs starting with a vertical bar, place a contact between the left power rail and the 
vertical bar. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 17814]  

• Resolving the logic of FBD POUs with a manual execution order may require additional kernel 
execution cycles compared to the automatic execution. Anomaly first identified in ISaGRAF 
version 6.4. [Rockwell TFS 23702] 
There is no workaround. 

• For variables using library-defined structure types with initial values, build errors occur after 
modifying the data types of the structure members since the initial values of these structure 
members are not reset after performing the modifications. Anomaly first identified in ISaGRAF 
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version 6.5. [Rockwell TFS 38311] 
To work around this issue, remove the incorrect initial values after modifying the data types of 
structure members by changing the data type of the variable to any other type and then back to 
the original data type. 

• When downloading a new IEC application where the virtual addresses and sizes of retained 
variables remain the same, previously retained values for such variables may be reused. 
Anomaly first identified in ISaGRAF version 6.3.2. [Rockwell TFS 44581] 
To work around this issue, avoid downloading multiple applications with the same name and 
virtual addresses for retained variables. 

• I/O variable values are not updated when the I/O Device window is docked. Anomaly first 
identified in ISaGRAF version 6.4. [Rockwell TFS 23479] 
To work around this issue, force a refresh in the window by clicking on another I/O device 
instance. 

• When opening an FBD POU while monitoring an application, tooltips display incorrectly with the 
__MO_ prefix. Anomaly first identified in ISaGRAF version 6.2. [Rockwell TFS 12990] 
There is no workaround. 

• The power flow debugging coloring displays incorrectly for rejected items. Rejected items are 
usually variables for which ISaGRAF is unable to resolve the access path. Rejected items appear 
in the Output window. Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 40366]  
To work around this issue, chunk the access path for such variables using intermediary variables 
until producing the expected debugging behavior. 

• When attempting to rename an IEC 61499 program to the same name as another existing 
program, an incorrect error message appears. Anomaly first identified in ISaGRAF version 6.2.2. 
[Rockwell TFS 51931] 
To work around this issue, use unique names.  

• The function or function block dictionary displays internal and hidden structures from the .tdb 
file. Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 54287]  
There is no workaround. 

• Forcing a value on a wired structure output member that is locked overwrites only the first 
member of the structure. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 64548]  
There is no workaround. 

• When monitoring multiple projects in a solution, only one project remains monitored after a 
few hours. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 65799]  
To work around this issue, specify the project that requires monitoring by right-clicking the 
project in Solution Explorer, and then selecting Set as StartUp Project. 

CAM 3 
 

• When opening a project containing ISaVIEW documents located directly under a device node, 
POUs are hidden for devices with names other than the default naming such as "Device1". 
Anomaly first identified in ISaGRAF version 6.4.1. [Rockwell TFS 43385] 
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To work around this issue, perform either of these steps to ensure the complete display of 
elements in the Solution Explorer. 

o Rename the devices to use the default naming, then close and reopen the project. 
o Place the ISaVIEW documents under POUs rather than under the device node. 

• Passing a MESSAGE type variable as input for a REAL standard operator may cause a runtime 
fault. Anomaly first identified in ISaGRAF version 6.6. [Rockwell TFS 40295] 
To work around this issue, for the REAL operator, use any data type other than MESSAGE. 

• For SFC steps and transitions, the renumbering feature applies the Sx and Tx naming convention 
used for CAM 5 SFC. Anomaly first identified in ISaGRAF version 6.3. [Rockwell TFS 38136] 
There is no workaround. 

• When the data value for defined words exceeds the possible value range, the compiler may not 
specify an out-of-range error. Anomaly first identified in ISaGRAF version 6.4. [Rockwell TFS 
18134] 
There is no workaround. 

• The compiler optimization options produce incorrect TIC code. Anomaly first identified in 
ISaGRAF version 6.3. [Rockwell TFS 8311] 
To workaround this issue, avoid applying these options. 

• When importing variables for a function, an extra variable named 'NewVariable' is also added. 
Anomaly first identified in ISaGRAF version 6.5. [Rockwell TFS 38310] 
To work around this issue, delete the extra 'NewVariable' variable.  

• An SFC program in the project may cause an incorrect program execution order. Anomaly first 
identified in ISaGRAF version 6.5. [Rockwell TFS 64534] 
To work around this issue, place SFC programs before ST, LD, and FBD programs in the Programs 
node in Solution Explorer. 

Additional Information (6.6.8) 
For a list of every item addressed, see the file C:\Program Files (x86)\Schneider 
Electric\SCADAPack Workbench\SCADAPack Workbench\Release Notes.html installed with 
SCADAPack Workbench. 

SCADAPack Workbench 6.5.0 Release Notes 

Application Version 
The SCADAPack Workbench application version is 6.5.0 (build 6.5.2146). 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.75 for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.63 for SCADAPack 4203 controllers 
o 2.23 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   
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o 1.75 for NOCT60 
• The latest SCADAPack E firmware at the time of release is 8.13.1 for SCADAPack E remote 

Programmable Automation Controllers (rPACs) and Remote Terminal Units (RTUs). 

New Features and Enhancements (6.5.0) 
• Windows 10 (32-bit and 64-bit) support. 
• SCADAPack Target 3 supports Sequential Function Chart (SFC) Programmable Organization Units 

(POUs) with some limitations: 
o Monitoring is not available while in simulation or running mode. 
o SFC macro steps (macro beginning steps, macro steps, and macro ending steps) are not 

supported. 
• A Diagnostic view provides real-time statistical information about Target 3 and Target 5 applications.  
• SCADAPack ES/ER templates for firmware versions 8.12.5+ include 8 new function blocks: 

o MODBUS_SETUP_RD_BOOL 
o MODBUS_SETUP_RD_REAL 
o MODBUS_SETUP_RD_UDINT 
o MODBUS_SETUP_RD_UINT 
o MODBUS_SETUP_WR_BOOL 
o MODBUS_SETUP_WR_REAL 
o MODBUS_SETUP_WR_UDINT 
o MODBUS_SETUP_WR_UINT 

• SCADAPack sp350v1 and sp357v1 templates have been created for Target 3 projects that provide 
default I/O for 5 V/20  mA boards.  

Improvements (6.5.0) 
• Migration to the Microsoft Visual Studio 2013 isolated shell: 

o The Solution Explorer provides new capabilities, including: 
 Searching the contents of the tree structure. 
 Collapsing and expanding tree structure views. 
 Scoping a specific element of the tree structure. 
 Passing from the default tree structure view to the previous or next view. 

• The LD language editor includes the following improvements: 
o While dragging rungs, blocks, coils, contacts, jumps, returns, and branches, the language 

editor displays the possible drop points. 
o While debugging, the Ctrl-T keyboard shortcut toggles the Boolean logical value of a 

selected contact, coil, or block input. 
o Improved ability to select rungs using Control and Shift keys with a left-mouse click. 
o Improved keyboard navigation using the arrow keys. 

• The Cross References Browser includes the following improvements: 
o Searches for Target 3 cross references. 
o Improved filtering options. 
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o Improved visibility of results including highlighting variable, block, or defined word search 
results and displaying locations for cross references. 

Functional Changes (6.5.0) 
• When installing SCADAPack Workbench 6.5.0 on a computer that was running a previously licensed 

version, a message states that the free version is running. This means you need to activate the 
SCADAPack Workbench 6.5.0 license. To obtain new license registration keys, contact Schneider 
Electric customer support at ordersTRSS@schneider-electric.com. 

• When installing SCADAPack Workbench 6.5.0, the new communication settings defined in 
C:\ProgramData\Schneider Electric\6.5\Schneider Electric Gateway\OpcConfig.xml file are applied 
to SCADAPack Workbench. If you were running a previous version of SCADAPack Workbench and 
now experience communication issues, revert the IxlTimeoutMultiFactor, 
ConnectRetryTimeInterval, and ConnectNoResponseTimeOut values in the OpcConfig.xml file to 
their previous values. 

• For POUs created in SCADAPack Workbench 6.3.0 or earlier, you need to open a local copy of the 
POU, make a change, then save the POU to ensure the XML files are updated to the current 
SCADAPack Workbench version. 

• SCADAPack Workbench cannot load projects with an invalid name. Valid project names begin with 
letters followed by letters, digits, and single underscore characters. Names cannot be reserved 
words or data types (defined words or arrays). 

Technical Notes (6.5.0) 
• The following issues are corrected by installing the Visual Studio 2013 Update 5 available at 

https://www.microsoft.com/en-ca/download/details.aspx?id=48129 
o The incomplete display of some or all toolbox items upon resetting for FBD, LD, SFC, or ST 

programming languages. 
o For the online help, hypertext links jumping to the top of the page rather than in the specific 

paragraphs within the same page. 
o The inability to change menu items from uppercase to mixed case. 
o The wrongful inclusion of the non-implemented "Order Help on DVD" menu item from the 

Help menu. 
• When performing searches from the Solution Explorer to locate specific items within the tree 

structure, searches are case-insensitive for lowercase text in the search field. However, searches 
become case-sensitive upon entering uppercase text in the field. Microsoft states this behavior is as 
designed: https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-
explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive  

• When SCADAPack Workbench displays a message stating that the ACP has encountered a problem, 
please take the time to generate a report to help us improve the quality of our product. When 
generating a report, you can choose to capture and attach a screenshot. Upon generation, a dialog 
box indicates the location and name of the report where you can choose to send the file to our 
technical support team at supportTRSS@schneider-electric.com. For such problems, make sure to 

mailto:ordersTRSS@schneider-electric.com
https://www.microsoft.com/en-ca/download/details.aspx?id=48129
https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive
https://connect.microsoft.com/VisualStudio/feedback/details/1078288/solution-explorer-search-filter-is-case-sensitive-it-should-be-case-insensitive
mailto:supportTRSS@schneider-electric.com
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close SCADAPack Workbench without saving changes to your project and restart the software to 
avoid corrupting files. 

Fixed Issues (6.5.0) 
Target 3 and Target 5 
• Issue: A defined word name could exceed the 252 maximum character length, causing unexpected 

behavior in SCADAPack Workbench. 
Fix: The defined word name is properly validated to prevent unexpected behavior. 
Engineering Reference: IES6-1087 
 

• Issue: ISaVIEW projects could not be exported as templates using the “Export as Template” feature.  
Fix: The “Export as Template” functionality for ISaVIEW projects has been corrected. 
Engineering Reference: IES6-1094 
 

• Issue: Focusing on an ISaVIEW window during a download caused unexpected behavior in 
SCADAPack Workbench. 
Fix: Display and focus issues on ISaVIEW pages have been corrected. 
Engineering Reference: IES6-1097 
 

• Issue: The Document Viewer sometimes caused unexpected behavior in SCADAPack Workbench.  
Fix: The Document Viewer is now more stable and no longer causes SCADAPack Workbench to crash 
if its position is changed. 
Engineering Reference: IES6-1099 
 

• Issue: Tag names on the LD canvas were truncated in a way that made them difficult to read. 
Fix: Long tag names are truncated in the middle using "...", and a tooltip is provided to indicate the 
full tag name when hovering over a variable.  
Engineering Reference: IES6-1170 

 
Target 5 Only 
• Issue: The controller status was reported as "not alive" on the first download attempt if a program 

was already running in the RTU. 
Fix: The Target 5 download mechanism has been improved and no longer reports “not alive” on 
download if a program already exists and is running. 
Engineering Reference: IES6-837 
 

• Issue: SCADAPack Workbench becomes unresponsive after attempting to access a variable after 
communication is lost. 
Fix: Target 5 communication is now more robust to help prevent SCADAPack Workbench from 
becoming unresponsive. 
Engineering Reference: IES6-941 



 

Internal 

 
• Issue: The Modbus Master function block documentation was incomplete. 

Fix: The Modbus Master function block documentation has been improved. 
Engineering Reference: IES6-1150, IES6-1178 
 

• Issue: Documentation did not state that the Windows Runtime Modules are not supported on 
SCADAPack firmware. 
Fix: The Migrating ISaGRAF 3 Workbench Projects to SCADAPack Workbench documentation now 
includes a more detailed list of unsupported features. 
Engineering Reference: IES6-1175 

Target 3 Only 
• Issue: The “IsRetained” checkbox did not properly display in the variable table, although the value 

was correct. 
Fix: The control window is now refreshed as expected. 
Engineering Reference: IES6-844 
 

• Issue: An "Application stopped" message was displayed in the output window after a download, 
even though the application was running in the device. 
Fix: The Output window is now cleared after the download is complete. 
Engineering Reference: IES6-846 
 

• Issue: The Cross Reference browser did not find all references of the object. 
Fix: The Cross Reference browser now retrieves all expected results. 
Engineering Reference: IES6-944 
 

• Issue: Users could not enter simulation mode if SCADAPack Workbench was opened via an *.acfproj 
or *.isasln file in Windows Explorer. 
Fix: The working directory for the SCADAPack Workbench project is correctly defined and projects 
that are opened from Windows Explorer can be debugged using the Simulator. 
Engineering Reference: IES6-1102 
 

• Issue: The Cycle Timing value was not reset when a new debug instance was initialized. 
Fix: The Cycle Timing value is cleared and applied as expected. 
Engineering Reference: IES6-1124 
 

• Issue: Documentation for Modbus Setup blocks was incorrect. 
Fix: The documentation has been improved. 
Engineering Reference: IES6-1143 
 

• Issue: Variable instances were not recognized in the Spy List when adding the “Add to Spylist” 
option from the context menu. 



 

Internal 

Fix: The Spy List functionality has been improved. 
Engineering Reference: IES6-1169 
 

• Issue: Target 3 projects were sometimes automatically rebuilt when attempting to enter debug 
mode, causing a version mismatch between the rPAC and SCADAPack Workbench. 
Fix: Projects are no longer automatically rebuilt when entering a debug session. 
Engineering Reference: IES6-1190 
 

For a list of every item addressed, see the file AcpResolvedIssues.txt in C:\Program Files (x86)\Schneider 
Electric\SCADAPack Workbench\SCADAPack Workbench.  
 

Known Issues/Known Customer Difficulties (6.5.0) 
Target 3 and Target 5 
• Issue: Attempting to run multiple instances of SCADAPack Workbench may cause unexpected 

behavior. 
Workaround: Run a single instance of SCADAPack Workbench. 
Engineering Reference: N/A 
 

• Issue: The Instruction List (IL) programming language is not implemented. You cannot open Program 
Organization Units (POUs) written in this language. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: When creating elements, names with more than 32 characters can exceed the maximum path 
name length supported by Microsoft Windows operating systems.  
Workaround: Avoid using names with more than 32 characters. 
Engineering Reference: N/A 
 

• Issue: The “Find and Replace” feature’s "Find Next" and "Replace" commands are available only 
within the context of the ‘Current Document’ for POUs. 
Workaround: Perform Search and Replace for a POU by clicking Ctrl+F, then setting the ‘Look In’ 
field to ‘Current Document’ and using only the “Find Next" or "Replace" commands.  
Engineering Reference: ISE6-1153 
 

• Issue: Toolbox icons are not displayed properly when using a Windows display setting other than 
100%. 
Workaround: Use only Windows display settings of 100% when running SCADAPack Workbench. 
Engineering Reference: N/A 
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• Issue: You cannot drag POU body elements between different programming language containers. 
Trying to do so can cause unexpected behavior in SCADAPack Workbench. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: The dictionary displays an incorrect lock status for variables.  
Workaround: Use the Locked Variables viewer to see the correct lock status for variables. 
Engineering Reference: N/A 
 

• Issue: The Block Library or Variable Selector is not automatically displayed for Ladder Diagram (LD) 
POUs when you double-click on coils and contacts in the Toolbox.  
Workaround: To display the Block Library or Variable Selector, insert coils and contacts in the 
Toolbox, then double-click on them. 
Engineering Reference: N/A 
 

• Issue: Using the Document Overview for a Function Block Diagram (FBD) POU can cause unexpected 
behavior in SCADAPack Workbench.  
Workaround: N/A 
Engineering Reference: ISE6-1099 
 

• Issue: When using the Documentation Generator, the generated document is dependent on the 
zoom level of the open FBD POU. 
Workaround: Close all POUs before generating the document. 
Engineering Reference: N/A 
 

• Issue: When resetting the toolbox for FBD, LD, SFC, or ST programming languages, the icons for 
some or all elements may not display correctly. 
Workaround: Close and reopen SCADAPack Workbench. 
Engineering Reference: N/A 
 

• Issue: In the Customize dialog box for menu bar, toolbar, and context menu items, avoid applying 
the "Reset All" command since this operation may cause unexpected behavior. 
Workaround: To remove the effects of the "Reset All" command, you can reset all environment 
settings to their defaults by choosing Tools > Import and Export Settings then selecting the "Reset all 
settings" option. 
Engineering Reference: N/A 
 

• Issue: Real values are displayed as integers in ISaVIEW text variables. 
Workaround: N/A 
Engineering Reference: IES6-1114 
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• Issue: Opening the Diagnostics window while offline may cause SCADAPack Workbench to become 
temporarily unresponsive. 
Workaround: Avoid opening the Diagnostics window when not actively connected to a device. 
Engineering Reference: IES6-1235 

Target 5 Only 
• Issue: If you download a new IEC 61131-3 application with virtual addresses and retained variable 

sizes that are the same as an existing application, the existing values for these variables may be 
reused in the new application.  
Workaround: Avoid downloading multiple applications that have the same names and sizes for 
retained variables. 
Engineering Reference: N/A 
 

• Issue: I/O variable values are not updated when the I/O Device window is docked.  
Workaround: To view updated values, click on another I/O Device instance to force the window to 
refresh. 
Engineering Reference: N/A 
 

• Issue: A virtual address overlap occurs if you delete an IEC 61131-3 function with an anonymous 
array as a complex parameter and the function uses the complex parameter (usually the case).  
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: Copying programs with wired array variables can cause unexpected behavior in SCADAPack 
Workbench.  
Workaround: Delete the array variables in the copied program. 
Engineering Reference: N/A 
 

• Issue: Copying FBD POUs from programs to function blocks can cause unexpected behavior in 
SCADAPack Workbench.  
Workaround: Copy subsets of the POU body between programs and function blocks. 
Engineering Reference: N/A 
 

• Issue: You need to unwire wired variables before modifying the dimension. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: Running an application that contains non-instantiated Sequential Function Chart (SFC) 
function blocks with SFC child blocks can cause unexpected behavior on the target.  
Workaround: N/A 
Engineering Reference: N/A 
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• Issue: Since the release of Target 5, the behavior of SFC steps with non-stored (N) action qualifiers 
has been modified to comply with the IEC 61131-3 standard.  SFC steps are now executed when they 
are activated and when they are deactivated. 
Workaround:  If the action only needs to be executed once, replace the N qualifier with a P0 or a P1 
qualifier in the action's properties in applications that have non-stored (N) action qualifiers in SFC 
Steps. 
Engineering Reference: N/A 
 

• Issue: If you open an FBD POU while monitoring an application, tooltips are incorrectly displayed 
with the __MO_ prefix.  
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: You cannot monitor the values of arrays that have a variable as an index.  
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: When using ISaVIEW documents, you cannot access individual integer bits. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: ISaGRAF eXchange Layer (IXL) communication with a target may be unsuccessful. 
Workaround:  Try the following: 

o Start simulation from the toolbar to test communications with the simulator. 
o Use the Windows Add/Remove Programs feature to verify that the "OPC Core components 

redistributable" item is installed. 
o If the SCADAPack Workbench runtime is installed on a quad-core computer, set the CPU 

affinity to one core. 
Engineering Reference: N/A 
 

• Issue: Function block input and output labels are displayed using pin ids instead of full names.   
Workaround: View the full name of the input/output in the Block Selector view. 
Engineering Reference: ISE6-692 
 

• Issue: When attempting to debug or simulate a project with a number of variables that exceed the 
available memory, the output window displays the "OPC server is unable to load project..." message 
and the "OutOfMemoryException: calling OPC Server shutdown" error message. The debugging or 
simulation process terminates and SCADAPack Workbench returns to project editing mode. 
Workaround: N/A 
Engineering Reference: N/A 
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• Issue: When updating a solution or resource from an exchange file, the variables are missing from 
the variable groups. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: When editing the properties of a POU body, you need to click elsewhere in the editor 
workspace before proceeding. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: When the compiler is unable to produce TIC code for FBD networks, the error list displays a 
warning message stating that the element is part of a tree not producing any code.  
Workaround: To enable the production of TIC code, you need to modify the network: 

- For rungs starting with a vertical bar, place a contact to the left on the rung. 
- For networks having a loop, replace the loop with variables. 

Engineering Reference: N/A 
 

• Issue: Loops in FBD networks may produce unexpected execution order results. 
Workaround: When placing loops in FBD networks, verify that the execution order follows your 
intended results. 
Engineering Reference: N/A 
 

• Issue: Resolving the logic of FBD POUs with a manual execution order may require additional kernel 
execution cycles compared to using automatic execution. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: For variables using library-defined structure types with initial values, build errors occur after 
modifying the data types of the structure members because the initial values of these structure 
members are not reset after performing the modifications. 
Workaround: To remove the incorrect initial values after modifying the data types of structure 
members, change the data type of the variable to any other type, then back to the original data 
type. 
Engineering Reference: N/A 
 

• Issue: Starting debugging with closed FBD POUs containing user-defined functions causes the error 
icon to be displayed on the block either when the POU is opened during simulation or when 
simulation is stopped. 
Workaround: Open all FBD POUs containing user-defined functions before debugging. 
Engineering Reference: N/A 
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• Issue: When using the document generator on a SFC program, embedded transitions where ST or LD 
are used do not get generated and are therefore not documented. 
Workaround: N/A 
Engineering Reference: ISE6-1201 

Target 3 Only 
• Issue: Recursive folders may be created when importing ISaGRAF 3 Workbench projects into 

SCADAPack Workbench. 
Workaround: 

o Choosing the folder where the *.hie file is stored can cause unexpected behavior in 
SCADAPack Workbench. Choose a different folder.  

o ISaGRAF 3 Workbench project folder names with more than eight characters can cause 
unexpected behavior in SCADAPack Workbench. Before importing, shorten the ISaGRAF 3 
Workbench folder name if necessary. 

Engineering Reference: ISE6-1033 
 

• Issue: Device names with more than 8 characters cause unknown compilation events. 
Workaround: Avoid using device names with more than 8 characters. 
Engineering Reference: N/A 
 

• Issue: After running a project with a POU, then deleting the POU, SCADAPack Workbench may not 
prompt you to rebuild the project before restarting simulation. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: The values of unused variables are displayed as Offline. 
Workaround: N/A 
Engineering Reference: ISE6-963 
 

• Issue: The compiler optimization options produce unstable results. 
Workaround: Avoid applying these options. 
Engineering Reference: N/A 
 

• Issue: Importing variables removes all I/O wiring connections. 
Workaround: Rewire variables after importing. 
Engineering Reference: ISE6-1013 
 

• Issue: Simulating Target 3 projects requires administrator privileges.  
Workaround: Run SCADAPack Workbench with administrator privileges: 

1.  Locate the SCADAPack Workbench application and right-click on it. 
2.  Choose Run as administrator. 

 Engineering Reference: N/A 
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• Issue: The Cross References Browser does not display cross references for Target 3 SFC POUs. 

Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: Support for imported Instruction List (IL) programming in SFC may be incomplete. This 
programming is displayed in steps with header and footer delimiters as in ISaGRAF 3. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: After modifying an SFC program with SFC children, the project needs to be cleaned. 
Workaround: N/A  
Engineering Reference: N/A 
 

• Issue: When copying an SFC POU that calls SFC children, the copied POU displays correctly in the 
Solution Explorer. However, the SFC actions calling the children are not copied; these actions are 
empty. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: For SFC steps and transitions, the renumbering feature applies the Sx and Tx naming 
convention used for Target 5 SFC 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: When the data value for defined words exceeds the possible value range, the compiler may 
not specify an out-of-range error. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Issue: Unloading then reloading a Target 3 library project is not recommended as this may cause 
unexpected behavior in SCADAPack Workbench. 
Workaround: Unload the library project, close the solution, re-open the solution, then reload the 
library project. 
Engineering Reference: N/A 
 

• Issue: When importing variables for a function, an extra variable named “NewVariable” is added. 
Workaround: Delete the extra NewVariable variable. 
Engineering Reference: N/A 
 

• Issue: The “Execution Order” feature is not implemented for Target 3 FBD POUs. 
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Workaround: N/A 
Engineering Reference: IES6-1141 
 

• Issue: Local defined words cannot be selected from the variable selector in a POU. 
Workaround: Do not use the Variable Selector popup that is accessed by double-clicking on a 
variable. Instead, use the quick access variable dropdown selector to assign a local defined word to a 
variable. 
Engineering Reference: IES6-1155 
 

• Issue: Entering a negative “Cycle Timing” value causes unexpected behavior.   
Workaround: Do not enter negative values in the “Cycle Timing” control. 
Engineering Reference: IES6-1122 
 

• Issue: Downloading a project while the I/O Wiring window is active may cause unexpected behavior 
in SCADAPack Workbench. 
Workaround: Close the I/O Wiring window before downloading a project. 
Engineering Reference: IES6-1129 
 

• Issue: Updating the communication settings after renaming a device may cause unexpected 
behavior. 
Workaround: Avoid opening the Diagnostics window when not actively connected to a device. 
Engineering Reference: IES6-1194 
 

• Issue: Variables may appear to retain their initial value after a clean or a rebuild. 
Workaround: Close the variable (VAR) window and re-open it to force the user interface to refresh. 
Engineering Reference: IES6-867 
 

• Issue: Cannot start debugging for a Target 3 program in the RTU. 
Workaround: Erase the Target 3 program in the RTU, re-download it to the device, then try to start 
debugging again. If that doesn't work, create a new SCADAPack Workbench project, clean the 
solution, build it, download it to the RTU, then try to start debugging again.   
Engineering Reference: IES6-1242 
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SCADAPack Workbench 6.4.1 Release Notes 

Application Version 
The SCADAPack Workbench application version is 6.4.1 (build 1.4.1233). 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.75  for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.63 for SCADAPack 4203 controllers 
o 2.23 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   
o 1.75  for NOCT60 

• The latest SCADAPack E firmware at the time of release is 8.12.4 for SCADAPack E remote 
Programmable Automation Controllers (rPACs) and Remote Terminal Units (RTUs). 

New Features and Enhancements (6.4.1) 
These features are included: 
• SCADAPack 500 E templates for firmware versions 8.12.4+ include 3 new HART function blocks: 

HART_CMD, HART_DEVICE_SCAN and HART_MTL4851_CTRL.  

Improvements (6.4.1) 
These improvements are included: 
• Improved installation feedback and logging.  

Fixed Issues (6.4.1) 
These issues are fixed: 
• Issue: Projects are automatically rebuilt before downloading, which may cause communication 

timeouts. 
Fix: Projects are no longer rebuilt before downloading or entering a debug session.  
Engineering Reference: ISE6-1146 

Known Issues/Known Customer Difficulties (6.4.1) 
These issues are known: 
• Issue: Visual Studio Service Pack 1 may require manual installation.  

Workaround: Visual Studio Service Pack 1 can be installed from the prerequisites folder on the DVD 
(Prerequisites\VS2010ISO\SP1\setup.exe), or it can be downloaded from the Microsoft website.   
Engineering Reference: ISE6-1142 
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SCADAPack Workbench 6.4.0 Release Notes 

Application Version 
The SCADAPack Workbench application version is 6.4.0 (build 1.4.1233). 

Firmware Versions 
• The latest SCADAPack firmware at the time of release is: 

o 1.75  for SCADAPack 314, SCADAPack 330, SCADAPack 334, SCADAPack 350, and SCADAPack 
357 controllers  

o 1.63 for SCADAPack 4203 controllers 
o 2.23 for SCADAPack 32 and SCADAPack 32P controllers  
o 2.50 for SCADAPack 100 controllers   
o 1.75  for NOCT60 

• The latest SCADAPack E firmware at the time of release is 8.12.2 for SCADAPack E remote 
Programmable Automation Controllers (rPACs) and Remote Terminal Units (RTUs) 

New Features and Enhancements (6.4.0) 
These features are now supported: 
• Windows 8 and Windows 8.1 operating systems 
• Foxboro NOCT (model NOCT60) Target 3 project configurations 
• Target 3 document generation 

Improvements (6.4.0) 
These improvements are included: 
• Improved stability and robustness of the SCADAPack Workbench installer 
• Improved stability and robustness of the Online Change feature 
• Improved functionality of the Document Generator 
• Improved robustness of Target 5 Application Package  
• Added support for the Delete key in Function Block Diagram (FBD) comment blocks 
• Improved legibility of text in variable box in FBD programs 
• Improved contrast between text and background colors of FBD and Ladder Diagram (LD) elements 
• Simplified documentation for Target 3 library dependency referencing  
• Corrected various typos in the documentation and SCADAPack templates 

Corrections (6.4.0) 
These items are fixed: 
• Item: I/O Wiring offset was not respected when importing a Target 3 project from ISaGRAF 3 

Workbench. 
Fix: Wiring offsets are now retained when importing a Target 3 project from ISaGRAF 3 Workbench 
into SCADAPack Workbench. 
Engineering Reference: ISE6-1032 
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• Item: Function Block programs did not clearly indicate power flow in debug mode. 
Fix: Power flow is now properly indicated in Function Block programs when in debug mode. 
Engineering Reference: ISE6-706 
 

• Item: Users could not enter a REAL constant in a variable box. 
Fix: Corrected numeric format validation inconsistencies in the variable box element. 
Engineering Reference: ISE6-974 
 

• Item: The option to add a Target 5 dependency was missing from SCADAPack E templates. 
Fix: Added the “Add Dependency” option to the Solution Explorer. 
Engineering Reference: ISE6-981 
 

• Item: A prompt indicated the project had to be rebuilt when attempting to download the project to 
a controller. Pressing Cancel stopped the download; pressing OK could result in a communication 
timeout. 
Fix: Removed the prompt so the compiled project can be downloaded without interruption. 
Engineering Reference: ISE6-432 
 

• Item: The Device Selector dialog box sometimes hid the OK and Close buttons. 
Fix: Adjusted the button position on the Device Selector dialog box. 
Engineering Reference: ISE6-662 
 

• Item: Mismatched data types between variables and function blocks caused power lines to turn red 
in Function Block Diagram (FBD) programs. 
Fix: Fixed data type inconsistencies between variables and function blocks. 
Engineering Reference: ISE6-895 
 

• Item: Local variables contained within a single ISaGRAF 3 Workbench project each needed a unique 
name to be imported into SCADAPack Workbench regardless of their scope. 
Fix: Local variables are now validated against name and scope when they are imported into 
SCADAPack Workbench.   
Engineering Reference: ISE6-943 
 

• Item: Variable formats were validated differently when importing projects and when exporting 
projects. 
Fix: Import and export validation is now consistent. 
Engineering Reference: ISE6-854 
 

• Item: The "Launch SCADAPack Configurator" menu option disappeared after adding a custom 
dependency to a SCADAPack Target 3 project. 
Fix: The "Launch SCADAPack Configurator" menu option is now available for valid SCADAPack 
solutions. 
Engineering Reference: ISE6-1006 
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• Item: Refreshing a function block reverted changes without saving them. 

Fix: Function block modifications are now retained as expected when a change is made.   
Engineering Reference: ISE6-1011 
 

• Item: Target 5 projects had to be downloaded one resource at a time. 
Fix: Changed communication timeouts so two resources can be downloaded at the same time. 
Engineering Reference: ISE6-1015 
 

• Item: An unexpected OPC event occurred when downloading Target 5 projects. 
Fix: Changed the SCADAPack Workbench installer so OPC components are installed as expected. 
Engineering Reference: ISE6-1056 
 

• Item: I/O devices did not show new I/O variables immediately after they were added. 
Fix: Changed the user interface display refresh interval so I/O variables are displayed immediately 
after they are added. 
Engineering Reference: ISE6-999 
 

• Item: The Deployment View was not updated after a device was deleted. 
Fix: Changed the user interface display refresh interval so the Deployment View is updated when 
changes are made. 
Engineering Reference: ISE6-638 
 

• Item: Channel variables were still shown after the I/O device was deleted. 
Fix: Changed the user interface display refresh interval so channel variables are no longer shown 
after the I/O device is deleted. 
Engineering Reference: ISE6-678 
 

• Item: Target 3 Structured Text (ST) programs could not be edited after they were downloaded. 
Fix: Changed the user interface display refresh interval so ST programs can be edited after they are 
downloaded. 
Engineering Reference: ISE6-848 
 

For a list of every item addressed, see the file AcpResolvedIssues.txt in C:\Program Files (x86)\Schneider 
Electric\SCADAPack Workbench\SCADAPack Workbench.  
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Items to be Aware Of (6.4.0) 
Target 3 and Target 5 
• Item: The Instruction List (IL) and Sequential Function Chart (SFC) programming languages are not 

implemented. You cannot open Program Organization Units (POUs) written in these languages. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: You cannot drag POU body elements between different programming language containers. 
Trying to do so can cause unexpected behavior in SCADAPack Workbench. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: The dictionary displays an incorrect lock status for variables.  
Workaround: Use the Locked Variables viewer to see the correct lock status for variables. 
Engineering Reference: N/A 
 

• Item: The "Save Solution/Project as" feature is no longer available.  
Workaround: Use Windows Explorer to make a copy of the project, then rename it. 
Engineering Reference: ISE6-972, IES6-1043 
 

• Item: The Block Library or variable selector is not automatically displayed for Ladder Diagram (LD) 
POUs when you double-click on coils and contacts in the Toolbox.  
Workaround: To display the Block Library or variable selector, insert coils and contacts in the 
Toolbox, then double-click on them. 
Engineering Reference: N/A 
 

• Item: Using the Document Overview for a Function Block Diagram (FBD) POU can cause unexpected 
behavior in SCADAPack Workbench.  
Workaround: N/A 
Engineering Reference: ISE6-1099 
 

• Item: Unable to enter simulation mode if SCADAPack Workbench was opened via an *.acfproj or 
*.isasln file in Windows Explorer. 
Workaround: Do not open project or solution files directly from Windows Explorer.  Open 
SCADAPack Workbench, then use the File > Open command to open project and solution files. 
Engineering Reference: ISE6-1102 
 

• Item: In the ISaVIEW context menu, the Delete and Rename options can be selected even when they 
are invalid options. 
Workaround: N/A 
Engineering Reference: ISE6-1093 
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• Item: The ISaVIEW Export as Template context menu option may generate an exception. 
Workaround: N/A 
Engineering Reference: ISE6-1094 
 

• Item: The Add > ISaVIEW from Template context menu option may not find the path to the 
template. 
Workaround: N/A 
Engineering Reference: ISE6-1095 
 

• Item: Selecting the ISaVIEW page while an application is downloading may cause the SCADAPack 
Workbench application to close. 
Workaround: N/A 
Engineering Reference: ISE6-1097 
 

Target 5 Only 
• Item: After downloading SCADAPack Workbench projects with two resources, communications with 

the rPAC or RTU may be lost. 
Workaround: Restart the rPAC or RTU. 
Engineering Reference: ISE6-1085 
 

• Item: If you download a new IEC application with virtual addresses and retained variable sizes that 
are the same as an existing application, the existing values for these variables may be reused in the 
new application.  
Workaround: Avoid downloading multiple applications that have the same names and sizes for 
retained variables. 
Engineering Reference: N/A 
 

• Item: I/O variable values are not updated when the I/O Device window is docked.  
Workaround: To view updated values, click on another I/O Device instance to force the window to 
refresh. 
Engineering Reference: N/A 
 

• Item: A virtual address overlap occurs if you delete an IEC function with an anonymous array as a 
complex parameter and the function uses the complex parameter (usually the case).  
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: Copying programs with wired array variables can cause unexpected behavior in SCADAPack 
Workbench.  
Workaround: Delete the array variables in the copied program. 
Engineering Reference: N/A 
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• Item: Copying FBD POUs from programs to function blocks can cause unexpected behavior in 

SCADAPack Workbench.  
Workaround: Copy subsets of the POU body between programs and function blocks. 
Engineering Reference: N/A 
 

• Item: You need to unwire wired variables before modifying the dimension. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: Running an application that contains non-instantiated Sequential Function Chart (SFC) function 
blocks with SFC child blocks can cause unexpected behavior on the target.  
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: Since the release of Target 5, the behavior of SFC steps with non-stored (N) action qualifiers 
has been modified to comply with the IEC 61131-3 standard. As a result, SFC steps are now executed 
when they are activated and when they are deactivated. 
Workaround:  If the action only needs to be executed once, replace the N qualifier with a P0 or a P1 
qualifier in the action's properties in applications that have non-stored (N) action qualifiers in SFC 
Steps. 
Engineering Reference: N/A 
 

• Item: If you open an FBD POU while monitoring an application, tooltips are incorrectly displayed 
with the __MO_ prefix.  
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: You cannot monitor the values of arrays that have a variable as an index.  
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: When using ISaVIEW documents, you cannot access individual integer bits. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: ISaGRAF eXchange Layer (IXL) communication with a target may be unsuccessful. 
Workaround:  Try the following: 

o Start simulation from the toolbar to test communications with the simulator. 
o Use the Windows Add/Remove Programs feature to verify that the "OPC Core components 

redistributable" item is installed. 



 

Internal 

o If the SCADAPack Workbench runtime is installed on a quad-core computer, set the CPU 
affinity to one core. 

Engineering Reference: N/A 
 

• Item: When creating elements, names with more than 32 characters may exceed the maximum path 
name length supported by Microsoft Windows operating systems.  
Workaround: Avoid using names with more than 32 characters. 
Engineering Reference: N/A 
 

• Item: Function block input and output labels are displayed using pin ids instead of full names.   
Workaround: View the full name of the input/output in the Block Selector view. 
Engineering Reference: ISE6-692 
 

• Item: The controller status may be reported as “not alive” on first download attempt.   
Workaround: Attempt to download the project again. 
Engineering Reference: ISE6-837 

Target 3 Only 
• Item: Recursive folders may be created when importing ISaGRAF 3 Workbench projects into 

SCADAPack Workbench. 
• Workaround: 

o Choosing the folder where the *.hie file is stored can cause unexpected behavior in 
SCADAPack Workbench. Choose a different folder.  

o ISaGRAF 3 Workbench project folder names with more than eight characters can cause 
unexpected behavior in SCADAPack Workbench. Before importing, shorten the ISaGRAF 3 
Workbench folder name if necessary. 

Engineering Reference: ISE6-1033 
 

• Item: Device names with more than eight characters cause unknown compilation events. 
Workaround: Avoid using device names of more than 8 characters. 
Engineering Reference: N/A 
 

• Item: After running a project with a POU, then deleting this POU, SCADAPack Workbench may not 
prompt you to rebuild the project before restarting simulation. 
Workaround: N/A 
Engineering Reference: N/A 
 

• Item: The values of unused variables are displayed as Offline. 
Workaround: N/A 
Engineering Reference: ISE6-963 
 

• Item: The compiler optimization options produce unstable results. 



 

Internal 

Workaround: Avoid applying these options. 
Engineering Reference: N/A 
 

• Item: Importing variables removes all I/O wiring connections. 
Workaround: Variables need to be rewired after importing. 
Engineering Reference: ISE6-1013 
 

• Simulating Target 3 projects requires administrator privileges.  
Workaround: Run SCADAPack Workbench with administrator privileges: 

1.  In your computer’s Start menu, locate the SCADAPack Workbench application and right-click 
on it. 
2.  Choose Run as administrator. 

 Engineering Reference: N/A 
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